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●●●● You can find the latest information (in English) on the provided software program at our world wide web 
server at http://www.jvc-victor.co.jp/english/index-e.html

● Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.

● Macintosh is a registered trademark of Apple Computer, Inc.
● Other product and company names included in this instruction manual are trademarks and/or registered 

trademarks of their respective holders.

CAUTION:
● Operate this equipment according to the operating procedures described in this manual.
● Use only the provided CD-ROM. Never use any other CD-ROM to run this software.
● Do not attempt to modify this software.
● Changes or modifications not approved by JVC could void user’s authority to operate the equipment.

How to handle a CD-ROM
● Take care not to soil or scratch the mirror surface (opposite to the printed surface). Do not write anything 

or put a sticker on either the front or back surface. If the CD-ROM gets dirty, gently wipe it with a soft 
cloth outward from the center hole using a circular motion.

● Do not use conventional disc cleaners or cleaning spray.
● Do not bend the CD-ROM or touch its mirror surface.
● Do not store your CD-ROM in a dusty, hot or humid environment. Keep it away from direct sunlight.
M1D6L-PhotoNaviTOC.fm Page 4
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EN 5INTRODUCTION
This document consists of the following four sections and an Appendix.
Before use, please read the Software Installation and USB Connection Guide for preparation.

���� Loading Still Images (Windows®)
This section explains how to load still images into the album of the Digital Photo Navigator software.

���� Playing Back and Handling Images (Windows®)
This section explains how to handle still images using the Digital Photo Navigator software. You can send still 
images by e-mail and store an album as a web page.

���� Title converter (Macintosh)
This section explains how to use the Title converter software to convert your own original images into 
camcorder title files.

���� ImageMixer (Windows® and Macintosh)
This section introduces the ImageMixer software. In addition to capturing still images and creating albums, 
ImageMixer is used for a variety of other functions, including color and brightness adjustment, and capturing 
videos through a USB cable or a DV cable. For details, refer to the ImageMixer online help.

���� Appendix
This appendix explains how to load images into the PC that does not have a USB connector, and how to use 
the titles and sound effects included on the CD-ROM with a camcorder. This appendix also contains 
troubleshooting and index.

Reading this document
02M1D6L-PhotoNavi.fm Page 5
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INTRODUCTION (cont.)
The following symbols are used in this document.

NOTE:
Indicates problems that could occur while using these softwares, phenomena that may appear to be a 
problem, limitations on the use of these softwares, or other information that is useful to know.

�
Indicates pages where related information can be found.

CONTINUED ON NEXT PAGE
Indicates that the explanation continues on the next page.

Under copyright law, any material that you may edit with this software cannot be used for any purpose other 
than your own personal enjoyment without the permission of the copyright holder. Note that this restriction 
applies when dubbing tracks from a CD as background music for your own movies.

Meanings of symbols

Copyrights
02M1D6L-PhotoNavi.fm Page 6
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Everyone has video cassettes and memory cards containing videos and pictures that they never get to show to 
anyone.
No matter how wonderful, the only people that got to see them were families and guests, because there was 
no convenient way to show them except in your own home on the TV. Friends and relatives who live far away 
had no way of viewing them. And you don’t want to throw those video cassettes and memory cards away 
because they hold treasured memories.
Now you can solve all of these problems with a PC. By using a USB cable to connect a camcorder to a PC, 
you can copy video clips from the camcorder to the PC. You can then send the files to anyone as an e-mail 
attachment.

Can I do this with my PC?
Yes, as long as your PC has a USB connector.

Aren’t most video data files too large to send easily as e-mail attachments?
In the case of video, using the camcorder function to copy the video to a memory card will result in a smaller 
file. In the case of still images, you can use this software to reduce the file sizes.

If you have a lot of image files with similar names, it can be hard to remember which file contains which 
image.
You can use this software to display these images on your PC just as if you had pasted them in a photo album. 
Because you can scan through these images just as if you were flipping through a photo album, you can 
quickly find a specific image that you want to send through e-mail, for example.

Can I distribute copies of albums?
You can save albums in web page format. When the album is saved in this format, anyone with a browser can 
view the album on any type of PC. Because the album is already in web page format, you can also exhibit 
your photos on the Internet.
Under copyright law, it is illegal to distribute copyrighted images without the permission of the copyright 
holder. Make sure that you have permission to distribute such images before actually doing so.

Send your favorite videos and pictures by e-mail

Create a virtual album
02M1D6L-PhotoNavi.fm Page 7
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ENDLESS POSSIBILITIES (cont.)
Add title images to the camcorder
You can use a title image in the camcorder to add a title scene to a video clip or add a frame to images for 
printing. We have also put together a collection of 38 titles on the provided CD-ROM. You can transfer any of 
these titles to your camcorder.
You can also create your own titles. After creating the desired image using a paint program, use this software 
to convert the image to a title that you can transfer to your camcorder.

Edit your own movies
Edit your own original movies by processing and re-arranging video clips and still images that you have 
loaded into your PC. Now you can be the director! Just shoot video with your camcorder and then edit it on 
your PC.
Once you have finished your movie, you can play back it on your PC, send it through e-mail, or even show it 
on the Internet.

Add a camera to your PC
You can transform your camcorder into a peripheral for your PC.
For example, when you are shooting a video, you can record on your PC instead of on a cassette. You can 
also use Windows® NetMeeting (or similar software) in combination with this software to hold a video 
conference over the Internet. (In order to conduct a video conference over the Internet with Windows® 
NetMeeting, you must register with MSN Messenger and Microsoft HotMail.)

Other applications
02M1D6L-PhotoNavi.fm Page 8
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Loading Still Images (Windows®)

The Digital Photo Navigator software allows you to store and view still 
images in a photo album format, and to convert your own original images 
into title files for your camcorder.
The icons on the Digital Photo Navigator window have the same functions 
as the menus. In this section, almost all the procedures are explained using 
the icons.
Read this section if you are using a Windows® operating system.

Menus

Icons
02M1D6L-PhotoNavi.fm Page 9
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10 EN ADDING STILL IMAGES TO AN ALBUM
You can use Digital Photo Navigator to create an album that contains a collection of still images.

1 Select [Start] – [Programs] – [Digital Photo 
Navigator] – [Digital Photo Navigator 1.0].
Digital Photo Navigator starts.
● Close any other programs running on the PC.
● Disable any programs that run in the background, such 

as screen savers, e-mail applications, virus checkers, 
schedulers, etc.

● Turn off file and printer sharing.

2 Click [Import].

3 Click [Image].
The [Open] dialog box appears.

4 Open the folder that contains the desired still images.
● Select the folder of the still images copied to the PC and 

click [Open].
● When loading images from a memory card, select the 

folder in the [DCIM] folder within [Removable Disk] and 
click [Open].

The still image files appear in the window.

5 Select the desired still image files and click [Open]. 
The still images are added to the right-hand side of 
the Digital Photo Navigator window.
● You may select more than one file.
● You can also add files by dragging and dropping them in 

the Digital Photo Navigator window.

6 Add additional still images as desired by repeating 
steps 3 – 5.

NOTES:
● When loading images from a memory card, never disconnect 

the USB cable while the message [ACCESSING FILES] is 
displayed in the camcorder’s LCD monitor.

● Digital Photo Navigator can only load still images and titles. Digital Photo Navigator cannot load video 
clips and sound effects.

CONTINUED ON NEXT PAGE
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ADDING STILL IMAGES TO AN ALBUM (cont.)
7 Click [Export].

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the 
album, input the file name of the album, and then 
click [Save].
The album is saved.

● If you save an album for the first time after the software 
installation, a message appears and asks if you want to 
register the association of the file extension name “jia”. 
Then, click [Yes].

● To exit Digital Photo Navigator, refer to “Exiting Digital 
Photo Navigator” (� pg. 12).
02M1D6L-PhotoNavi.fm Page 11
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12 EN EXITING DIGITAL PHOTO NAVIGATOR
1 Click the [File] menu and then click [Exit].
● If you have already saved an album, a confirmation message 

appears. Then, go to step 2.

● If you have not saved an album after loading still images, a 
confirmation message appears.
To save an album, click [Yes]. The [Save as] dialog box 
appears. Specify the location where you want to save the 
album, input the file name of the album, and then click 
[Save]. A confirmation message appears. Then, go to step 2.
To exit Digital Photo Navigator without saving an album, 
click [No]. A confirmation message appears. Then, go to 
step 2.

2 Click [Yes].
Digital Photo Navigator closes.
02M1D6L-PhotoNavi.fm Page 12
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Playing Back and Handling Images (Windows®)

This section explains how to handle still images using Digital Photo 
Navigator.
You can send still image files as an e-mail attachment and store an album 
as a web page. Be sure to read “Loading Still Images (Windows®)” before 
reading this section.
The icons on the Digital Photo Navigator window have the same functions 
as the menus. In this section, almost all the procedures are explained using 
the icons.
Read this section if you are using a Windows® operating system.

Menus

Icons
02M1D6L-PhotoNavi.fm Page 13
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14 EN LOADING AN ALBUM
1 Start Digital Photo Navigator.
2 Click [Import].

3 Click [Album].
The [Open] dialog box appears.

4 Open the folder where the album was saved.

5 Click the desired album file, and then click [Open].
The contents of the album are displayed in the right-hand 
side of the Digital Photo Navigator window.

6 Click [Export].

NOTES:
● You can also open the album file by dragging and dropping it in the Digital Photo Navigator window.
● If an album is currently open, a confirmation message 

appears.
• If you want to open the newly selected album instead of 

the one already opened, click [Yes]. If you have not saved 
the album already opened, a confirmation message 
appears. If you want to save the album, click [Yes]. If you 
do not want to save the album, click [No].

• If you want to add still images from the newly selected album to the album already opened, click [No].
02M1D6L-PhotoNavi.fm Page 14



Master Page: Right-Heading0
EN 15DISPLAYING STILL IMAGES
You can select for display any of the still images that are displayed in the right-hand side of the Digital Photo 
Navigator window.

1 Double-click the still image to be displayed.
The [Image Viewer] window appears, and the selected image is displayed.

To display a series of images in “slide show” fashion, click the  button in the [Image Viewer] window. You 
can also move through the images manually in either direction by clicking the  and  buttons.

To adjust the speed of the slide show, right-click the [Image Viewer] window and then, in the menu that 
appears, click [Slide show] – [Setting Interval Time]. Set the length of the interval (in seconds), and then click 
[OK].

NOTE:
The interval for a slide show is a little longer than the setting because of display processing time.

Displaying a selected still image

Displaying a series of images

Stop slide show

First image Last image

Next image

Start slide show

Previous image
02M1D6L-PhotoNavi.fm Page 15
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DISPLAYING STILL IMAGES (cont.)
The following procedure describes how to change the display size of a still image.

1 Drag the corner of the [Image Viewer] window to change the size of the window to the desired 
display size.

2 Right-click the [Image Viewer] window and then, in the 
menu that appears, click [Zoom] – [Auto].
The size of the still image is automatically enlarged or reduced to 
fit the window, and the display magnification (enlargement/
reduction percentage) indicated in the title bar of the window 
changes accordingly.

Other enlargement/reduction functions
In addition to adjusting the size of the image to the size of the 
window, the display size of a still image can also be changed by the 
methods described below. Each of these functions can be selected by 
right-clicking the [Image Viewer] window.
● [Zoom] – [Real Size]: Displays the image in its original size (display magnification of 100%).
● [Zoom] – [Zoom In]: Displays the image at twice its current display magnification (up to 400%).
● [Zoom] – [Zoom Out]: Displays the image at half its current display magnification (up to 20%).

Enlarging and reducing images

Display magnification
02M1D6L-PhotoNavi.fm Page 16
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EN 17ORGANIZING ALBUMS
Whenever necessary, you can delete or copy still images that you have added to an album. The procedure 
described below only affects the still image in the album. It does not affect the original file of the still image 
that was added to the album.

To delete or copy multiple still Images at once, select them in advance. You can also select all still images in 
the album.

Selecting still images continuously
Click still images while holding down the Shift key.

If you click one still image while holding down the Shift key, the images of smaller numbers are selected as 
well.

Selecting still images one by one
Click still images while holding down the Ctrl key.

Selecting all of the still images
Click [Select All] in the [Edit] menu.

Selecting multiple still images

Shift + Click

Click

Ctrl + Click
02M1D6L-PhotoNavi.fm Page 17
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ORGANIZING ALBUMS (cont.)
1 Click the still image that you want to delete, and then 
click [Delete] in the [Edit] menu.
A confirmation message appears.

2 Click [Yes].
The selected still images are deleted.

1 Click the still image that you want to copy, and then 
click [Copy] in the [Edit] menu.

2 Click the image that is located right after the 
insertion point.
● To add the images at the end of the album, click the 

blank space in the right-hand side of the window.

3 Click [Paste] in the [Edit] menu.
The copied still images are inserted right before the 
selected image.

NOTE:
You can delete, copy or paste an image also by right-clicking 
it.

Deleting unnecessary still images

Copying still images

Insertion point
02M1D6L-PhotoNavi.fm Page 18
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EN 19SENDING IMAGES FROM AN ALBUM IN E-MAIL
Still images in an album can be sent as an e-mail attachment.

Preparation: Before using the [E-Mail] function
If you use the Internet Explorer, be sure to use the version 5.5 or later.
When installing the Internet Explorer, select a typical set of components.

1 Click the still image that you want to send, and 
then click [E-Mail].
The new message window in your e-mail program 
appears, and the still image file is registered as an 
attachment.

NOTES:
● Depending on an e-mail software, a new message window 

may not open when the [E-Mail] button is clicked.
● Depending on an e-mail software, settings such as “Set as 

MAPI client” or “Used by MAPI application” are necessary.
● The maximum number of messages that can be created at 

once is three.
02M1D6L-PhotoNavi.fm Page 19
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20 EN CREATING A WEB PAGE
You can save the contents of an album in HTML format. This is useful in the following instances:

When creating a web page: You can create a web page that features a collection of photos.
When distributing an album: You can create an album in a format that can be displayed by a web 

browser. This is useful if you want to distribute the album on CD-R, etc.

1 Select the still images that you want to save in 
HTML format.
● To select more than one still image, hold down the Shift 

key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the 

[Edit] menu.

2 Click [Web Page].
The [Web Page] dialog box appears.

3 Set the following items when necessary.
● [Title]: This will be the title of the web page.
● [Font Color]: This specifies the color of the title text.
● [Back Color]: This specifies the background color of the 

web page. (Specify a color other than the font color.)
● [Limit horizontal size of the images]: This allows you to 

specify the maximum width of the image when 
displayed by a web browser. (Set the number of pixels 
much smaller than the width of the PC’s display.)

CONTINUED ON NEXT PAGE
02M1D6L-PhotoNavi.fm Page 20
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CREATING A WEB PAGE (cont.)
4 Click [OK], specify the save location, and then 
click [Save].
The HTML file is saved, and a folder with the same 
name is saved at the same time. A confirmation 
message appears next, asking whether to display the 
web page.

5 Click [Yes].
The web browser opens, and the HTML file that was 
created is displayed.
● Click on an image on the web page to enlarge it.

What Next?
You can also view an HTML file through the web browser by double-clicking the HTML file. You can upload 
the HTML file to your home page, or save it on a CD-R or some other media and distribute it.
Always handle HTML files and folders as a set. Without its folder, an HTML file cannot be viewed by a web 
browser.

NOTES:
● For more details on how to create a home page, consult your Internet service provider’s web site or one of 

the many reference books available.
● Use third-party home page creation software or similar software to edit HTML files.
02M1D6L-PhotoNavi.fm Page 21
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22 EN CHANGING THE IMAGE SIZE OR PICTURE QUALITY
This procedure describes how to change the size of an image that has been loaded into Digital Photo 
Navigator. This procedure is used to reduce the size of an image that is being attached to an e-mail or saved in 
an album.

1 Select the still image to be changed.
● To select more than one still image, hold down the Shift 

key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the 

[Edit] menu.

2 Click [Change Format].
The [Image Format] dialog box appears.

3 Select one of the following items:
● [Expansion/Reduction]: Set any desired image size in 

the [Width] and [Height] fields. If the [Keep aspect 
ratio] check box is not selected (off), both [Width] and 
[Height] fields can be changed.

● [Generic Size]: Select the size from a list of generic 
sizes.

● [PDA Size]: This is an image size (160 x 160) that can 
be displayed on most PDAs.

4 Click [OK].
● If you select more than one still image in step 1, a 

confirmation message appears.
• If you want to apply the same format to all images, click [Yes].
• If you do not want to apply the same format, click [No]. The first image is saved. Then, select the image 

size for each image.
The image size is changed to the selected size. If the vertical-to-horizontal ratio was changed, the blank 
spaces are shown as black.

Changing the image size
02M1D6L-PhotoNavi.fm Page 22
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CHANGING THE IMAGE SIZE OR PICTURE QUALITY (cont.)
In addition to changing the size of an image, it is also possible to rotate images, change or correct the quality 
of an image, and change the file format of an image. The role of each setting is described in more detail 
below.

[90 degrees Rotation]
If you hold the camcorder sideways when recording an 
image, you can create an image that is taller than it is 
wide. Because this still image will be displayed sideways, 
use this function to rotate the image 90 degrees to the 
portrait orientation.
[None]: No correction
[Clockwise]: Rotates the image 90 degrees clockwise.
[Counterclockwise]: Rotates the image 90 degrees 
counterclockwise.

[Image Correction (DV)]
NOTE:
The setting in the [Image Correction (DV)] field has an effect only when the still image was shot with a digital 
video camera.

Sometimes, when you shoot a subject that is moving very quickly, the resulting image will be blurred. It is 
possible to correct this blurring to a certain extent. Because the optimal type of correction depends on the still 
image, we recommend making a copy of the image and experimenting with the copy. It is not possible to 
correct for blurring caused by shaking the camera while shooting.
[None]: No correction
[Movement]: Corrects only the blurred portions.
[Field]: Corrects blurring more quickly than [Movement].

[Format]
You can select the file format of an image.
[JPEG]: This is the format that is typically used on the Internet. This format has a smaller file size.
[BITMAP]: This is the standard Windows® image format (BMP). Many applications can use this format.

[JPEG Quality]
This setting is available when JPEG was selected in the [Format] field. Moving the slider to the left makes the 
file smaller. Moving the slider to the right results in less deterioration in the image quality. The initial setting is 
75.

NOTES:
● When [JPEG] is selected in the [Format] field, the quality of the image deteriorates slightly each time that 

[OK] is clicked for the [Image Format] dialog box. To restore the original image quality, reload the original 
still image file.

● When you shoot a subject that is moving too quick, some blurring cannot be corrected with the setting in 
the [Image Correction (DV)].

● When [Field] is selected in the [Image Correction (DV)] field, the quality of the original image deteriorates.
● To confirm the file size, right-click the still image and then select [Properties].

Changing the picture quality, etc.
02M1D6L-PhotoNavi.fm Page 23
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24 EN RETRIEVING STILL IMAGES FROM AN ALBUM
You can retrieve still images from an album and save them as a file.

1 Select the still image to be retrieved.
● To select more than one still image, hold down the Shift 

key or the Ctrl key while clicking the images.
● To select all of the still images, click [Select All] in the 

[Edit] menu.

2 Click [Image].
The [Image Format] dialog box appears.

3 Change the image format as desired. (� pg. 22, 23) 
Then, click [OK].
● At this point, you can change the image size and picture 

quality as desired. (� pg. 22)
The [Save As] dialog box appears.

4 Specify the location where you want to save the file, 
input the file name, and then click [Save].
The image file is saved.
● If you select more than one still image in step 1, a 

confirmation message appears.
• If you want to save all images with the same image 

format and their default name, click [Yes]. The [Auto 
Save Result] dialog box appears. Then, click [OK].

• If you want to set the image format and input file name 
for each image, click [No]. The first image is saved. The 
[Image Format] dialog box appears for the second 
image. Repeat steps 3 and 4 as many times as 
necessary.
02M1D6L-PhotoNavi.fm Page 24
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EN 25CREATING A LIST OF STILL IMAGES
You can arrange multiple still images together and save them in a single still image file.

1 Holding down the Shift key or the Ctrl key, select 
the still images that are to be added to the list.

2 Click [Multi Image].
The [Multi Image] dialog box appears.

3 Select the number of partitions.
● Either 4, 9, or 16 partitions may be selected.

4 Click [Back Color], select the color for the overall 
background, and then click [OK].

5 Change the positions of the still images as desired.
● Deleting an image: Right-click the still image and then 

select [Delete].
● Adding an image: Drag an image from the right-hand 

side of the Digital Photo Navigator window to the 
[Multi Image] dialog box.

6 Click [Save].
The [Image Format] dialog box appears.

7 Change the image format as desired. (� pg. 22, 23) 
Then, click [OK].
● At this point, you can change the image size and picture 

quality as desired. (� pg. 22)
The [Save As] dialog box appears.

8 Specify the location where you want to save the 
file, input the file name, and then click [Save].
The still image list file is saved.
02M1D6L-PhotoNavi.fm Page 25
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26 EN CREATING A SLIDE SHOW OR AN ANIMATION
You can create a slide show or an animation in which a series of still images are displayed, and then save 
those images as a movie file (extension “.avi”).
[Slide Show]: Still images are displayed for several seconds each, one at a time.
[Animation]: Several still images are displayed per second. We recommend that you select a series of still 
images that create the appearance of continuous movement.

1 Holding down the Shift key or the Ctrl key, select 
several still images.

2 Click [Movie].
The [Movie Settings] dialog box appears.

3 Select either [Slide Show] or [Animation], which 
ever is desired.
● For a slide show, set the length of the interval (in 

seconds).
● For an animation, set the number of displayed frames 

(images) per second.

4 Set the following items when necessary.
● [Image Size]: Select the size of the movie file.
● [Compressor]: Select the type of compressor.
● [Back Color]: This item is used if the aspect ratio of the 

images is not 4:3.

5 Click [OK].
The [Save As] dialog box appears.

6 Specify the location where you want to save the file, input the file name, and then click [Save].
● The file name can be changed.
The movie file is saved, and a confirmation message that asks if you want to play the movie now appears.

7 Click [Yes].
The movie file is played back.

NOTES:
● If you change the [Compressor] item, make sure that the 

playback system supports that type of compressor.
● Depending on the selected type for [Compressor], a movie 

file cannot be created.
● In some cases, the settings in the [Video Compression] dialog box are invalid.
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EN 27CREATING A VIDEO TITLE
A still image that was created by graphics drawing or processing software can be converted into a title file 
(extension “.ttl”) for use by camcorders. For details on the title files on the provided CD-ROM, refer to 
page 49.

1 Create a still image with graphics drawing or 
processing software, and then save it as a file.
● For details on how to use the graphics drawing or 

processing software, refer to the instruction manual that 
was provided with the software.

2 Connect the camcorder to the PC with a USB cable.
● Refer to the “Connections (Windows®)” (� pg. 9) in the 

Software Installation and USB Connection Guide.

3 Load the file into Digital Photo Navigator. 
(� pg. 10)

4 Select the desired still image, and then click [Title 
Image].
The [Title Image] dialog box appears.

5 Move the slider to a suitable position.
● The farther down you move the slider, the more 

transparent the title background becomes. If you do not 
want the background to be transparent at all, click [Non-
cut out].

CONTINUED ON NEXT PAGE
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CREATING A VIDEO TITLE (cont.)
6 In the [Drive] field, select the name of the drive 
where the memory card is located, and then click 
[OK].
● The name of the drive where the memory card is located 

(“E:” for example) can be confirmed by checking [My 
Computer].

The file is converted into a title file and is stored in the 
appropriate folder in the memory card.

7 Disconnect the USB cable.
● Refer to the “Disconnecting the USB Cable (Windows®)” 

( � pg. 12) in the Software Installation and USB 
Connection Guide.

NOTE:
The still image displayed when moving the slider is a sample image. The title file saved in the memory card 
does not have the same appearance when displayed on the camcorder’s LCD monitor or viewfinder.
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Title converter (Macintosh)

You can use the Title converter software to convert your own original 
images into title files for use by camcorders.
Read this section if you are using a Macintosh.
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30 EN CREATING A VIDEO TITLE
A still image that was created by graphics drawing or processing software can be converted into a title file 
(extension “.ttl”) for use by camcorders. For details on the title files on the provided CD-ROM, refer to 
“Adding titles and sound effects” on page 49.

1 Create a still image with graphics drawing or 
processing software, and then save it as a file.
● For details on how to use the graphics drawing or 

processing software, refer to the instruction manual that 
was provided with the software.

2 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Macintosh)” (� pg. 13) in the 

Software Installation and USB Connection Guide.

3 Double-click the [Title converter] icon.
Title converter starts up.

4 Click the Open button.
The file selection dialog box appears.

5 Select the desired still image file, and click [Open].
The selected image file is displayed.
● When the still image file is not opened, add memory to 

the PC and increase the Memory Requirement setting of 
Title converter.

● The maximum image size that can be opened with Title 
converter is 1600x1200 dots.

Open

CONTINUED ON NEXT PAGE
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CREATING A VIDEO TITLE (cont.)
6 Move the slider to a suitable position.
● The farther down you move the slider, the area in which 

the background is visible becomes larger. If you do not 
want the background to be transparent at all and simply 
want to use the image as is for the title, move the slider all 
of the way to the top.

● To make fine adjustments to the slider position, click the 
Slider Fine Adjustment button. 

● To quickly check the appearance of the background 
image, click the Title Confirmation button. (If the file is 
saved at this time, adjustment made to the slider position 
is kept.)

7 Click the Volume Selection button and then select 
the memory card.
The name of the selected memory card appears.

8 Click the Save button.
The file is converted into a title file, and is renamed and 
stored in the appropriate folder in the memory card.
The file name under which the title file was saved is 
displayed.

9 Select [Quit] in the [File] menu.
The Title converter closes.

Slider Fine
Adjustment

Title Confirmation

Slider

Volume Name

Volume
Selection

File Name Save
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CREATING A VIDEO TITLE (cont.)
Using a still image with a different aspect ratio
The aspect ratio of a title is 3:4. If you use a still image with an aspect ratio that is not 3:4, either the vertical 
length or the horizontal length is adjusted automatically, depending on the settings.
To select whether to adjust the vertical length or the horizontal length of the still image, select [Source fitting] 
in the [Setting] menu to set it.

[Source fitting]: Select either the vertical length or the horizontal 
length of the source image to be applied when adjusting an aspect 
ratio. Any excess portion is cropped, or any blank portion is filled 
with the specified color to make the aspect ratio 4:3.
[Margin color]: Select the color of blank portion.
In order to apply the changes made to the settings, open the still 
image file again after the settings have been changed.

Check the transparent area easily
The transparent background area is diplayed in white on the Title 
converter window. When it is hard to view white area in an image of light color, etc., change the color of the 
background.
To change the color of the background, select [Transparent area color] in the [Setting] menu.

This setting is not used for the title image; it is only provided for checking the appearance on Title converter 
window.

This area is displayed in 
the selected color.
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EN 33INCREASE THE MEMORY REQUIREMENT SETTING
If the still image file cannot be opened with Title converter because the file is too large (� pg. 54), increase 
the memory requirement setting of Title converter performing the following procedure.

1 Select [Quit] in the [File] menu.
The Title converter closes.

2 Click the [Title converter] icon and select [Memory] 
of [Get Info] in the [File] menu.

3 Input the larger value in the [Preferred Size] box.

4 Close the [Title converter Info] window.

5 Start up the Title converter to open the still image 
file.
● If the still image file cannot be opened, repeat from 

step 1.
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ImageMixer (Windows® and Macintosh)

In addition to capturing still images and creating albums, ImageMixer is 
used for a variety of other functions, including color and brightness 
adjustment, and capturing video through a USB cable or a DV cable. 
Read this section whether you are using a Windows® or a Macintosh 
operating system.

Explanations of mode buttons are 
displayed here.
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EN 35IMAGEMIXER
The ImageMixer software possesses a variety of functions. Its primary applications are described below.

Editing your own original movies
ImageMixer allows you to capture video from a camcorder, rearrange scenes, add special effects when 
changing scenes, insert still images, and otherwise freely edit your own movies. ImageMixer also allows you 
to add audio and background music.
The edited movie is stored in MPEG1 format, which provides a comparatively smaller file size. This makes it 
more convenient to distribute it to your friends, for example, expanding the range of possibilities for which 
you can use your camcorder.

Capturing video from tape
Connect the camcorder to the PC with a DV cable. ImageMixer can then convert the video on tape to MPEG1 
format and store it in the PC. (Windows® Me and Windows® 2000 Professional only)

Capturing video in real time
Connect the camcorder to the PC with a USB cable. ImageMixer can then record on the hard disk in the PC, 
instead of on the tape. (Exclude Windows® 98)

Loading still images from a memory card
Connect the camcorder to the PC with a USB cable. ImageMixer can then load still images from a memory 
card.

Capturing audio from a microphone or CD
ImageMixer can record audio from the PC’s microphone. Because the recording can be made while playing 
the video back at the same time, it is easy to add audio that is in sync with previously recorded video. 
ImageMixer can also add music from a CD as background music for your movie.

Editing still images
ImageMixer can adjust the brightness and contrast of still images and extract only the necessary portions. 
ImageMixer also has a variety of functions for correcting eye color tones that are too red.
In addition, ImageMixer allows you to freely lay out still images, pictures, text, and other elements to create 
your own postcards, CD-R labels, etc.

Capabilities
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Managing files on hard disk
ImageMixer can manage elements that can be used in movie editing (video, still images, audio) as albums. 
Aside from permitting checking of files in list format or through a slide show, ImageMixer can also perform 
file operations such as search, move, duplicate, and delete. In addition to making movie editing easier, these 
functions are also useful for classifying and managing images with a camcorder.

This manual only provides an overview of ImageMixer. For more details on how to use its many functions, 
refer to the online help.
To display online help for Windows®, click the [?] button located in the upper right corner of the ImageMixer 
screen. Clicking this button launches the web browser and displays the online help.

For more details on how to use ImageMixer, refer to the following User Support Center.
North America (Los Angeles)
Telephone: +1-213-341-0163
Europe (U.K.)
Telephone: +44-1489-564-764
Asia (Philippines)
Telephone: +63-2-438-0090

IMPORTANT:
Differences from Digital Photo Navigator
Unlike Digital Photo Navigator, ImageMixer only registers the location of an image file and its thumbnail 
image in albums. When images are handled by ImageMixer, the original file is affected by the operation. 
For example, if an image is deleted from an album, the original file is deleted. If a file is moved, ImageMixer 
loses track of where the file resides. Therefore, file operations should be conducted carefully.

For more detailed information

PIXELA User Support Center
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EN 37CAPTURING VIDEO
When a camcorder is connected to the PC with a USB cable, the video from the camcorder can be recorded 
on the PC’s hard drive instead of on tape or in a memory card (real-time capture).

1 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” (� pg. 9) or “Connections (Macintosh)” (� pg. 13) in the Software 

Installation and USB Connection Guide.

2 Set the VIDEO/MEMORY Switch on the camcorder to “MEMORY”.

3 Set the Power Switch on the camcorder to “ ” or “ ”.
The camcorder is now on.
[Web CAMERA] appears on the camcorder’s LCD monitor.
● If [Web CAMERA] does not appear, install [USB Stream driver]. Refer to “Software Installation 

(Windows®)” ( � pg. 5) and “Software Installation (Macintosh)” (� pg. 14) in the Software Installation 
and USB Connection Guide.

● Camcorder operations are limited to the zoom switch, the focus button, and the still image button.

NOTE:
The procedure is different when reading or writing a memory card.

4 Select [Start] – [Programs] – [Pixela] – 
[ImageMixer] – [PIXELA ImageMixer 
Ver.1.0].

● For Macintosh, double-click the 
[ImageMixer] icon on the PC.

ImageMixer starts up.

5 Click the Input button.
The input mode screen appears.

Capturing video in real time

Input

CONTINUED ON NEXT PAGE
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CAPTURING VIDEO (cont.)
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6 Click the USB input (USB) button.
The USB input mode screen appears.

7 Click the Video button.
The amount of available storage space is 
displayed in the information display panel.

8 Click the Capture button.
The capture operation begins, and the message 
[Capture in progress] appears.

9 Click the Capture button again.
The capture operation ends, and the message 
[Converting to MPEG] appears. Once 
conversion ends, the video file (extension 
“.mpg”) is registered in the album.

NOTE:
If you are using Windows® 2000 and the MPEG1 
files cannot be converted to MPEG4 files with 
ImageMixer, install Windows Media™ Player 
(version 7 or later). Windows Media™ Player can 
be loaded from Microsoft’s web site: 
http://www.microsoft.com/

Capturing still images
1 Click the Still image button.

The message [Still image capture enabled] 
appears on the information display panel.

2 Click the Capture button.
The video image at the moment that the button 
was clicked is captured, and the resulting still 
image file (extension “.jpg”) is registered in the 
album.
● Camcorder operations are limited to the 

zoom switch, the focus button, and the still 
image button.

NOTES:
● It is not possible to capture videos or still images 

if the USB Mass Storage Class driver is not 
installed properly. In this case, refer to “Updating 
[Device Manager] (Windows®)” ( � pg. 8) in the 
Software Installation and USB Connection 
Guide.

● On the information display panel or the file 
information dialog, some information such as 
file-created date may be incorrect.

Disconnecting the USB cable
1 Disconnect the USB cable.
2 Set the Power Switch on the camcorder to “OFF”.

The camcorder turns off.

USB input (USB)

Capture

Video

Information display panel

Capture

Information display panelStill image
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When a camcorder is connected to the PC with a DV cable, video can be copied from the camcorder tape to 
the PC.

1 Set the VIDEO/MEMORY Switch on the camcorder to “VIDEO”.
2 Set the Power Switch on the camcorder to “ ”.

The camcorder is now on.

3 Select [Start] – [Programs] – [Pixela] – 
[ImageMixer] – [PIXELA ImageMixer 
Ver.1.0].
ImageMixer starts up.

4 Click the Input button.
The input mode screen appears.

5 Click the Digital video camera input (1394) button.
The Digital video camera input mode screen appears. After 
a while, a blue screen appears.

Capturing video from tape (Windows® only)

Input

Digital video camera input (1394) 
04M1D6L-ImageMixer.fm Page 39



40 EN

Master Page: Left

CAPTURING VIDEO (cont.)
Copying video
1 Click the Video button.

The amount of available storage space is 
displayed in the information display panel.

2 Click the Play button.
The camcorder begins playing back the video, 
and the same image appears on the PC screen.

3 Click the Capture button.
The capture operation begins, and the message 
[Video capture in progress] appears.

4 Click the Capture button again.
The capture operation ends, and the message 
[Converting to MPEG] appears. Once conversion 
ends, the video file (extension “.mpg”) is 
registered in the album.
● The camcorder stops playback automatically.

NOTE:
If you are using Windows® 2000 and the MPEG1 
files cannot be converted to MPEG4 files with 
ImageMixer, install Windows Media™ Player 
(version 7 or later). Windows Media™ Player can be loaded from Microsoft’s web site: 
http://www.microsoft.com/

Disconnecting the DV cable
1 Disconnect the DV cable.
2 Set the Power Switch on the camcorder to “OFF”.

The camcorder turns off.

NOTES:
● To copy a video as a still image, click the Still image button in step 1 of “Copying video” and perform 

steps 2 – 4.
● It is not possible to capture video keeping DV format. Use other DV capture application software available.

Capture

Video

Information display panel

Play
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ImageMixer can group and search for files (still images, video, and audio) registered in an album, according 
to their purpose. To playback a file, double-click on its thumbnail.

Menu

Select album Image editing

Change
display

Thumbnail

Search

Change display
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ImageMixer can edit video files registered in an album. ImageMixer can also insert still images and add 
audio.

Double-clicking on one of the (video or still image) thumbnails arranged at the bottom of the screen causes 
the editing window to appear. The beginning/ending of videos can be deleted and the volume can be 
adjusted. The display time for still images can be adjusted.

Select video editing Material selection

Edit

Thumbnail
Preview

Create video

Arrange
thumbnails

Apply scene 
change effects

Arrange audio
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EDITING VIDEO (cont.)
To check the results of editing, click the Preview button. Once editing is complete, click the Create video 
button to save the final product.

Cropping editing

Sound editing

Cropping

OK
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Appendix

This appendix explains how to use a camcorder to hold a video conference 
over the Internet, and how to use the titles and sound effects included on 
the provided CD-ROM with a camcorder. This appendix also contains 
troubleshooting and index.
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EN 45CONDUCTING A VIDEO CONFERENCE OVER THE INTERNET
You can use Windows® NetMeeting® to conduct video conferences over the Internet, using a camcorder.

Preparation
1 Confirm that Windows® NetMeeting® 3.0 or later and MSN Messenger Service is installed.

● You can download the latest version of Windows® NetMeeting® or MSN Messenger Service from 
Microsoft’s web site:
http://www.microsoft.com/

2 Install [USB Stream driver].
● Refer to “Software Installation (Windows®)” (� pg. 5) in the Software Installation and USB Connection 

Guide.
● If the installation of [USB Stream driver] has already been completed, go to step 3.

3 Connect the camcorder to the PC with a USB cable.
● Refer to “Connections (Windows®)” ( � pg. 9) in the Software Installation and USB Connection Guide.

4 Set the VIDEO/MEMORY Switch on the camcorder to “MEMORY”.

5 Set the Power Switch on the camcorder to “ ” or “ ”.
The camcorder is now on.
[Web CAMERA] appears on the camcorder’s LCD monitor.
● If [Web CAMERA] does not appear, install [USB Stream driver]. Refer to “Software Installation 

(Windows®)” ( � pg. 5) in the Software Installation and USB Connection Guide.
● Camcorder operations are limited to the zoom switch, the focus button, and the still image button.

NOTE:
The procedure is different when reading or writing a memory card.

6 Select [Start] – [Settings] – [Control Panel] and double click the [Multimedia] icon. Select the 
[Audio] tab and click [JVC DVCamera USB Michrophone] in the [Preferred device] box. Set 
the [Volume] to the highest.

7 Start NetMeeting®, and set up the program as instructed on the screen.
● An environment that provides for connection to the Internet and an e-mail address are also required.
● Select [JVC DVCamera USB Michrophone] as a recording device in the [Audio adjustment ] wizard.

8 In the [Conference] menu, click [Directory].
The [Find Other Party] dialog box appears.

9 Register with HotMail as instructed on the screen.

10 Set up MSN Messenger as instructed on the screen.
● If setup was completed previously, the MSN Messenger Service logon window appears.

11 Exit NetMeeting® and MSN Messenger Service.

Using Windows® NetMeeting® (Windows® Only)
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CONDUCTING A VIDEO CONFERENCE OVER THE INTERNET (cont.)
Videoconferencing
1 Connect to the internet.
2 Connect the camcorder to the PC with a USB cable.

● Refer to “Connections (Windows®)” ( � pg. 9) in the Software Installation and USB Connection Guide.

3 Set the VIDEO/MEMORY Switch on the camcorder to “MEMORY”.

4 Set the Power Switch on the camcorder to “ ” or “ ”.
The camcorder is now on.
[Web CAMERA] appears on the camcorder’s LCD monitor.
● If [Web CAMERA] does not appear, install [USB Stream driver]. Refer to “Software Installation 

(Windows®)” ( � pg. 5) in the Software Installation and USB Connection Guide.
● Camcorder operations are limited to the zoom switch, the focus button, and the still image button.

NOTE:
The procedure is different when reading or writing a memory card.

5 Start NetMeeting®, and click [Directory] in the [Conference] menu.
The MSN Messenger Service logon window appears.

6 Log on to the MSN Messenger Service as instructed on the screen.

7 In the list of [Current Friends Online], specify the party with whom you will videoconference.
You can now begin the videoconference if your friends respond. The same environment is necessary for 
your friends.

For details, refer to the help for the MSN Messenger Service and NetMeeting®. Details on how to uses 
NetMeeting® are expected to be available on the JVC web site.

JVC web site:
http://www.jvc-victor.co.jp/english/index-e.html

NOTES:
● If you are using Windows® 98, you cannot use the microphone in the camcorder. Either connect a third-

party microphone to the PC, or use the PC’s own microphone.
● If you are using a dial-up router or a broadband router, refer to the router’s instruction manual.
● If you are using a firewall or a router, it is not possible to connect to the internet properly.
● Consult your Internet service provider for details before using NetMeeting®.
● Depending on the condition of the line, the quality of images or sound during videoconferences may differ.
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CONDUCTING A VIDEO CONFERENCE OVER THE INTERNET (cont.)
Use iVisit (from Eyematic of the U.S.) if you are using a Macintosh or if you are conducting a videoconference 
between a Macintosh system and a Windows® system. It is not possible to conduct a videoconference 
between a system using iVisit and a system using NetMeeting®.

Operating requirements

For other requirements, refer to the Software Installation and USB Connection Guide.

How to use
The English version of iVisit can be downloaded for free from the web site indicated below (as of November, 
2001). Details on how to use iVisit are expected to be available on the JVC web site.

iVisit web site:
http://www.ivisit.com/

JVC web site:
http://www.jvc-victor.co.jp/english/index-e.html

Using iVisit

Windows : Windows® 98,
Windows® 98SE,
Windows® 2000 Professional

Macintosh : Mac OS 9.0.4 to 9.1
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48 EN LOADING FILES FROM A MEMORY CARD THROUGH AN ADAPTER
You can read and write files on a camcorder memory card by using an adapter (sold separately).

The following description assumes that a floppy disk adapter is being used. For details on how to use each 
specific type of adapter, refer to the instructions provided with that adapter.

1 Remove the memory card from the camcorder.
2 Insert the memory card in the floppy disk adapter.

3 Insert the floppy disk adapter into the floppy disk drive of the PC.

4 Copy the necessary files from the floppy disk to the hard disk.

Floppy disk adapter
(CU-VFSD50)

: For PCs that do not have a USB connector, or which are running Windows® 95/
NT.

PC card adapter
(CU-VPSD60)

: For PCs with a PC card slot

USB reader/writer
(CU-VUSD70)

: For applications that use numerous memory cards
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EN 49ADDING TITLES AND SOUND EFFECTS
The provided CD-ROM contains titles and sound effects files for use with camcorders.  In order to use these 
files, copy them to a memory card by the procedure described below.

1 Open a memory card through the PC.
● Connect the camcorder to the PC with a USB cable referring to the Software Installation and USB 

Connection Guide. Or use an adapter (� pg. 48).

2 Load the CD-ROM into the PC.

3 Open the folder indicated below in the CD-ROM.
● Title: Open the [TITLES] folder.
● Sound effects: Open the [DCSD] folder.

4 Select the file to be used with the camcorder.
● Titles: You can confirm the appearance on page 50.
● Sound effects: You can play the sound effect by double-clicking the file icon.

5 Copy the selected file from the CD-ROM to the memory card.
● Titles: Copy to the [TITLES] folder.
● Sound effects: Copy to the [100JVCGR] folder in the [DCSD] folder.
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ADDING TITLES AND SOUND EFFECTS (cont.)
List of titles
These are the titles in the [TITLES] folder on the provided CD-ROM.
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ADDING TITLES AND SOUND EFFECTS (cont.)
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52 EN TROUBLESHOOTING
Windows®

SYMPTOM CORRECTIVE ACTION REFER TO:

Although the USB cable is 
connected, PC operating 
system does not recognize the 
memory card in the 
camcorder.

•Make sure that the AC Power Adapter/Charger is 
connected to the camcorder and that the power is on.

Software 
Installation and 

USB 
Connection 

Guide
( � pg. 9)

•Make sure that the USB cable is connected securely.
•Either use a USB hub that has its own power supply, or 

connect the USB cable directly to the PC’s USB 
connector.

•Windows® might not be recognizing the USB connector. 
Make sure that the Universal Serial Bus controller is 
enabled on the [System Properties] sheet in the [Control 
Panel].

The connected camcorder 
cannot be detected. The COM 
port cannot be set.

•Make sure that the AC Power Adapter/Charger is 
connected to the camcorder and that the power is on.

Software 
Installation and 

USB 
Connection 

Guide
( � pg. 9)

•Make sure that the USB cable is connected securely.

•If you are using a built-in modem or IrDA, the RS-232C 
COM port may occupied. In this case, right-click [My 
Computer], then select [Properties]–[System Properties]–
[Device Manager]. Click [Ports (COM & LPT)] to confirm 
which COM port is available. If all the COM ports are 
occupied, set the COM port used by the modem or IrDA 
driver to [Invalid].

—

•Depending on your PC’s specifications, you may need to 
change the BIOS settings. —

Cannot copy or save files. •Make sure that there is enough free space available in the 
drive where you are trying to copy or save a file.

—

•Make sure that the drive where you are trying to copy or 
save a file is not write-protected.

•Make sure that a file with the same name does not 
already exist where you are trying to copy or save a file.

•Either use a USB hub that has its own power supply, or 
connect the USB cable directly to the PC’s USB 
connector.
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TROUBLESHOOTING (cont.)
Windows® (cont.)

SYMPTOM CORRECTIVE ACTION REFER TO:

Cannot load still images into 
Digital Photo Navigator.

•Sometimes the format of the still image data prevents it 
from being loaded into Digital Photo Navigator. Use 
other graphics drawing or processing software to convert 
the file to either bitmap format or JPEG format. —

•Make sure that there is enough free space available in the 
drive in which Digital Photo Navigator is installed.

Still images have a mosaic 
appearance.

•When a small image is loaded and enlarged, it will take 
on a mosaic appearance.

pg. 16

•If an image is saved with a lower JPEG quality or if the 
format of the image is changed, it will take on a mosaic 
appearance.

pg. 23

The colors displayed on the PC 
are odd.

•Images will not be displayed correctly if the display is set 
for 256-color (or fewer) display. —

NOTE:
When using a laptop PC, operation may be interrupted by a warning when the battery is nearly exhausted.
● If there is software which monitors the status of the battery running in the [StartUp] folder…

Close the application, or delete/move its icon from the [StartUp] folder and reboot your PC.
● If you are using your PC’s power management function…

Right-click the [My Computer] icon, then select [Properties]–[System Properties]–[Device Manager]–
[System Devices]–[Advanced Power Management Support]. Desactivate the power management 
function.
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TROUBLESHOOTING (cont.)
Macintosh

SYMPTOM CORRECTIVE ACTION REFER TO:

Although the USB cable is 
connected, PC operating 
system does not recognize the 
memory card in the 
camcorder.

•Make sure that the AC Power Adapter/Charger is 
connected to the camcorder and that the power is on.

Software 
Installation and 

USB 
Connection 

Guide
( � pg. 13)

•Make sure that the USB cable is connected securely.
•Either use a USB hub that has its own power supply, or 

connect the USB cable directly to the PC’s USB 
connector.

Cannot copy or save files. •Make sure that there is enough free space available in the 
drive where you are trying to copy or save a file.

—

•Make sure that the drive where you are trying to copy or 
save a file is not write-protected.

•Make sure that a file with the same name does not 
already exist where you are trying to copy or save a file.

•Either use a USB hub that has its own power supply, or 
connect the USB cable directly to the PC’s USB 
connector.

Still image files cannot be 
opened with Title converter.

•The file format is other than PICT, JPEG or BMP. Open the 
still image file with graphics drawing or processing 
software to save the file as PICT, JPEG or BMP. pg. 33•The file size is too large. add memory to the PC to get 
more than 128 MB. Then, increase the Memory 
Requirements setting of Title converter. 
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